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2
9:05 AM dBug Cafe at the RC: 9:05 AM 
- Noon 
10:00 AM Gathering at RC to discuss 
design issues & methods for ExChange II 

4
6:30 PM Beginning Mac User’s SIG at RC 
- Q&A and Troubleshooting 

5
7:00 PM Board Meeting at RC 

6
7:00 PM Seattle Final Cut Users Group, 
DVD Studio Pro, and Photoshop tutorials 

9
9:05 AM dBug Cafe at the RC: 9:05 AM 
- Noon 

12
7:00 PM WebObjects SIG at RC 

13
6:30 PM Holiday Party on the 17th instead 
of Main Meeting 

16
9:05 AM dBug Cafe at the RC 9:05 AM 

17
3:00 PM dBug Holiday Party in Renton 

18
7:00 PM FileMaker Pro SIG at RC 

19
6:30 PM Music SIG: GarageBand 

20
7:00 PM Mac OS X SIG at RC 

23
9:05 AM dBug Cafe at the RC 9:05 AM 

26
6:30 PM Intermediate Mac User’s SIG at RC 
- Cancelled due to holiday 

27
6:30 PM Digital Imaging SIG at RC 

Continued

dBug Holiday Potluck
When: 3:00-6:00pm on Sunday, December 17, 2006 

Details: On the ExChange 

Time for dBug’s Holiday Party!

Members and their guests are invited to our annual potluck party. This is 
purely a social party 
(no presentations 
or technical 
support) and a 
great opportunity 
to meet other 
members. Please 
bring one dish to 
share and anything 
you’d like to drink. 
Directions and more 
information are 
available on the dBug ExChange in the WaterCooler conference. If you are 
a dBug Member, but have not yet created your account on the ExChange, 
please contact dBug’s Party Coordinator for details. 

<http://www.dbug.org/about/contact.shtml?to=party_coordinator> 

ATTN: Mac Users Intermediate SIG
Tim Hannon’s Intermediate Mac User SIG <http://www.dbug.org/sigs/
macusers/> is moving from the 2nd Monday to the 4th Tuesday. There 
won’t be a December SIG meeting, so the first new night will be on 
Tuesday, January 24th, 2007.  Don’t miss the opportunity to learn 
interesting things about using your Mac.

Winterizing Your Mac 
By Mike Grueter

Updated November 16, 2006 - Originally released December, 2003

If you live in a cold winter climate you’ve surely winterized your home 
and your vehicle by now, but how many of you have thought to winterize 
your poor Macintosh? Of course, winterizing your Macintosh has little to 
do with climate and much to do with holiday spirit, but it is of incredible 
importance (at least at our house) nevertheless. What does “winterizing 
your Macintosh” mean? Well, if your Mac screen does not look like Snoopy’s 
doghouse in “A Charlie Brown Christmas”, read on to find out!

Note: the configuration steps and some of the software described here 
are for Mac OS X only, but some of the general ideas are useful for older 
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9:05 AM dBug Cafe at the RC 9:05 AM23
7:00 PM Xcoders SIG at RC 

25
9:05 AM dBug Cafe at the RC: 9:05 AM - 
Noon 

27
6:30 PM Internet SIG at RC - Browsers, 
Email, News, the Web 

30
10:05 AM dBug Cafe at the RC:          
10:05 AM - 12 PM

versions of Mac OS and even other operating systems (if you must).

The first and most dramatic step in winterizing your Mac is to find an 
appropriate desktop picture. You can hunt the web to find free desktop 
pictures, or you can use your own pictures. The Digital Imaging experts 
at dBug have made it even easier to find a nice desktop picture. Go to 
the dBug website to see the small images — click to view larger versions 
of each picture. Save any large images you like on your computer. More 
images will be added as they come in.

Just download the picture you like and follow these steps to configure 
your Mac to display the picture on your desktop:

1) Take the time now to clear all of the clutter from your Desktop. The 
beautiful new desktop picture you picked out will not look good with a 
bunch of files and folders all over it. Go ahead and put those items in your 
Documents folder or elsewhere. I’ll wait...

2) Put the desktop picture(s) you downloaded in an easy to find folder. If 
you share your Mac with other people who have their own accounts, you 
might want to put the pictures in a place they can access too. I keep mine 
in a folder titled “Holiday Desktop Pictures” in the “Shared” folder in the 
“Users” folder on my hard disk.

3) Choose “System Preferences...” from the Apple menu

4) In Mac OS X 10.3 or newer, click the “Desktop & Screen Saver” icon in 
the “System Preferences” window, and click the “Desktop” tab. If you are 
running an older version of Mac OS X, click the “Desktop” icon.

5) In Mac OS X 10.3 or newer, click “Choose Folder...” in the left-hand 
list, navigate to the folder you created in step 2 above, select the pictures 
folder, and click the “Choose” button. If you are running an older version 
of Mac OS X, select “Choose Folder...” from the “Collection” pop-up menu 
and pick your pictures folder.

6) You should see your holiday desktop picture(s) displayed in the 
window. If you want a single picture displayed on your desktop, click 
the picture and you’re done. If you downloaded more than one picture, 
you could have the desktop picture change as often as you want to keep 
things fresh, so click the “Change picture” checkbox and fiddle with the 
settings to get them just right.

Now that your desktop is showing a lovely holiday picture, the first thing 
you notice is that bare metal hard disk icon sitting at the top right corner 
of your screen. That just does not fit with our wintery theme, so we need 
to change it. Again, you can search the web for the perfect holiday icon. I 
found a few nice ones at these websites:

http://www.cedarseed.com/fire/icons.html

BlueJay

http://iconfactory.com/freeware/preview?id=187

http://iconfactory.com/freeware/preview?id=188

http://iconfactory.com/freeware/preview?id=257

http://www.wbchug.com/icons.php

http://www.sahoicon.com/icon/season_e.html#christmasdinner

http://interfacelift.net/icons-mac/categories.php?id=32

Volunteer Opportunities
dBug needs for Volunteers for helping 
with Main Meetings and the MacNews. 

Main Meetings
(1) Call for volunteers to arrange the RC 	

  room and set up chairs.
(2) Volunteers to put things away
(3) Sell raffle tickets and memberships 

at  the Main Meetings. (money to 
treasurer)

Mac News:
A.  Editor; organize material about next 

month’s events, especially the Main 
Meetings and the Classes

B.  Reporters
	 (1) Main Meeting Reports
	 (2) Class reports
	 (3) New and newer software
	 (4) Classic Software
	 (5) Mac items of interest
	 (6) Board business
C.  Distribution
	 (1) Make copies of formated pdf on 

dBug’s RC printer
	 (2) Organize putting labels on the 

mailed newsletters
	 (3) Make copies available at the RC
	 (4) Organize distribution of copies to 

Mac vendors via delivery or mail



Icons can come in a variety of formats. The easiest format to use is 
standard Mac icons. Other formats will work, but this tutorial shows how to 
do it with standard Mac icons. Download a suitable icon and follow these 
steps to change your hard disk icon:

1) Click once on the new icon to select it

2) Choose “Get Info” from the “File” menu

3) Click once on the icon in the Info window to select it

4) Choose “Copy” from the “Edit” menu and close the Info window

5) Click once on your hard disk icon to select it

6) Choose “Get Info” from the “File” menu

7) Click once on the icon in the Info window to select it

8) Choose “Paste” from the “Edit” menu and close the Info window

Now that we’ve got the right look for our desktops, lets get a little action 
going. There are several cool little programs that can liven things up a bit.

	 If you’ve already decorated your tree this year and miss the 
decorating rush, you’re in luck. Christmas Tree Creator by Spindrift Software 
is free software that lets you decorate digital trees to your heart’s content. 
You can even share the love by printing greeting cards, posters, emailing 
friends, or viewing your trees as animated screen savers.
•	 MacLampsX by The Arctic Mac draws animated blinking light bulbs around 

your screen.
•	 Holidock by Anomaly Industries puts a Christmas tree with changing 

lights and music in the Dock.
•	 Santa Menu is another free application which puts a little Santa icon in 

the menubar and makes a “Ho ho ho” sound every once in a while.
•	 Snow for Mac OS X by Rick Jansen is a $10 shareware program that adds 

some animation to your screen with small snowflakes piling up on your 
windows, polar bears wandering around, and Santa flying in his sleigh 
pulled by reindeer.

•	 And don’t forget to add a Snow Globe to your desktop. You can shake it 
up to send snow flying around the Christmas tree.

•	 Snö is a free program by Infinity-to-the-Power-of-Infinity which gives 
you more snowflake choices and behaviors. It looks great running along-
side Snow for Mac OS X. The Activity Monitor shows Snö to be a bit of a 
processor hog, so keep that in mind if your Mac starts to slow down.

•	 TreetopLights is a free AppleScript Studio application that places a 
Christmas tree on the desktop and holiday lights on the menubar or 
screen edges.

•	 Wreath-in-the-Dock by StimpSoft is another free application that puts a 
customizable wreath in the Dock.

•	 Xmas Lights is also free and it lets you hang lights from the menubar. 
There are settings for blinking as well as ways to customize the lights 
themselves.

•	 X-MasTree is a free Christmas Tree for your Mac with many options, in-
cluding which color lights to display, lighting modes (static, blinking or 
fading), a few ornaments, and a badge displaying days left until Christ-
mas.

Yes your Mac can look this cool, but just for the holidays OK?

Lets not leave our Macs idle while we’re not using them. Holiday screen 



savers are just the thing to keep our Macs busy while we’re off drinking egg 
nog or hot cider. Frosted, <http://www.skyrocketsoftware.com/Frosted/> 
from Skyrocket Software combines a winter wonderland scene with sound 
effects and a talking 3D snowman, or take a walk through a 3D Christmas 
Village, <http://www.scrnz.com/screensavers/christmasVillage.htm> from 
Scrnz. Big, Fat, Stinking Snowman, <http://home.comcast.net/%7Ejeff.
ulicny/software/screensavers.html> sports snowmen spinning and 
dancing in a 3D winter world of falling snow. NightLights, <http://www.
skyrocketsoftware.com/NightLights/> also from Skyrocket Software decks 
out your Mac screen with glowing configurable lights. A Very 3D Christmas 
Screensaver, <http://www.uselesscreations.com/mac/christmas/> by 
Useless Creations displays Santa, his Reindeer, and a hard working Elf in 3D 
as they fly through the air throwing presents down chimneys and randomly 
stopping at houses while Santa climbs down the chimney. IcoNVader, 
<http://www.daedale.com/products/iconvader/> by Daedale causes 
Christmas images to bounce around, flip over and finally explode in a kind 
of soap bubble effect. On the simpler side of things, paper-cut snowflakes 
pop on the screen and slowly spin and float away in Flakey Saver from 
<http://noah.cx/software/>. If you’re in the mood for something a little 
warmer, try Fireplace, <http://loops.twosailors.net/> by TwoSailors Network 
for a “real fireplace without running out of wood”. They have other real 
video loop screensavers including candle, iPod Christmas, and Santa and 
Snowman too.

If you’re running the latest Mac OS X 10.4 (Tiger), you might want to add 
a little holiday spice to your Dashboard as well. The Christmas Calendar, 
<http://www.ibrak.de/Pages/Applications/christmascalendar.html> lets 
you click onto the small “Mac-doors” to see what is behind, the well-
named Festive Lights, <http://www.interdimensionmedia.com/widgets/> 
hangs lights in your Dashboard, there are no less than 3 widgets to help 
you count the days, <http://www.gardnerdesigns.net/FreeStuff/Widgets/
widgetdownloads.html> until Christmas arrives, and Snowreport Widget, 
<http://www.powderfone.com/widget.php> by PowderFone brings you snow 
reports, updated every hour, every day incase you want to venture outside 
and plow through some real snow.

Don’t forget to add some soothing holiday music to the mix. Just rip some 
of your favorite holiday CDs in iTunes, or buy some holiday favorites from 
the iTunes Store, and press play.

Whew! Now that we’ve done all that work, it’s time to play. Circus by Mac-
Yun-Soft, Christmas Avalanche by Dracosoft, Christmas Crisis and Christmas 
Super Frog by Koingo Software, Christmas Quest by Spinapse, and Pinch ol’ 
Santa 2 by SwordLord might be just the thing to help you relax (or they 
might just push you over the edge too).

I’m sure the elves in Cupertino are hard at work developing 
iFiggyPuddingDispenser™, so we’ll have something new to try next year, 
but careful adherence to the steps in this tutorial should get our Macs 
through this winter anyway.

Mike Grueter is a co-leader of the Mac OS X SIG and owner of Sudden 
Technology.



Protect your MacBook
by Mike Grueter

Speck Products recently contacted dBug with a special discount offer on 
their latest product for the Mac, the SeeThru Hard Shell for 15” MacBook 
Pro. They also gave us one to review and a second one which we raffled off 
at our November Main Meeting.

What’s the point of wrapping your laptop in plastic? Well, the bottom 
of my older PowerBook laptop looks pretty beat up with scratches and 
missing rubber feet, and I’ve seen lots of other aluminum and titanium 
laptops with scratches and even dents, so I know I’m not alone. I consider 
myself a careful computer user too. The SeeThru Hard Shell is made of 
tough polycarbonate plastic which will definitely stop the wear and tear on 
a MacBook.

If you love the look of your silver MacBook Pro and just want the 
protection, there is a clear Hard Shell, but if you like to personalize and 
customize, get the hot red one. Currently, the Hard Shell comes in clear 
and red and only for the 15” MacBook Pro, but the folks at Speck Products 
said they are working on Hard Shells for other Mac laptops, starting with 
the 13” MacBooks, and they are considering other colors as well. Speaking 
of personalization, it is very easy to insert photos, logos, or business cards 
between the plastic and the laptop for a quick customization that is easy 
to undo without getting any gunk on your computer. I can see bumper 
sticker fans going nuts with this...

The Hard Shell is very easy to install and remove. You just set the MacBook 
in the bottom half of the shell and press down slightly to snap the clips 
into place. Set the upper half of the shell on top of the MacBook and press 
down, and that’s it. For removal, just pull the tabs away from the case on 
one side of the top and it slips off with no fuss. The bottom comes off 
easily by pulling on the front tabs in the same way. The Hard Shell gives 
the MacBook a slick, shiny look and there are curvy indentations that look 
pretty cool too. I expected the plastic to feel tacked-on and maybe move 
a little or feel loose, but it fits very snugly and feels good, though the 
plastic does slip in my hand more easily than the brushed aluminum does.

How does it work in day-to-day use? Pretty nicely. I didn’t have any 
trouble plugging in Ethernet, USB, and FireWire cables, and the 4 thumb 
drives I plugged in fit perfectly. I was worried that the port openings in 
the Hard Shell might not work for my biggest thumb drive, but it worked 
great. CD insert and removal was fine too. There is no opening for the 
battery, so I’ll have to remove the bottom of the case to replace the 
battery, but that is not something I do very often. I gave the MagSafe 
power plug a yank test and it passed with flying colors as well. Another 
worry I had was heat, but Speck Products addresses this issue with 
ventilation slots on the bottom of the case. My fans have not come on 
unexpectedly, so I don’t think heat will be an issue either.

For information on the special discount for dBug Members, see the “dBug 
Benefits” conference on the dBug ExChange. The offer lasts through the 
end of December 2006, so buy now to save money. I look forward to 
more case colors and Hard Shells for other laptop models (12” PowerBook 
please?), but I think they’ve got a winner on their hands.

<http://www.speckproducts.

com/15mac-seethru.html>



Omni Group Main Meeting Report:
Brian Covey, Support and QA Manager at The Omni Group, dropped by 
the dBug Resource Center to show us the latest versions of their award 
winning software products. He began by giving us a sneak-peak at their 
newest program called OmniPlan, which is software that helps manage 
projects. Brian showed us how to add people and tasks to a project, assign 
the tasks to people, allocate resources, and view a timeline showing the 
project completion. OmniPlan will be released soon, but you can download 
a fully-functioning beta version to try-out right now.

Brian continued his presentation with OmniGraffle which makes creating 
diagrams, flow charts, org charts, family trees, and office layouts easy. 
He even showed us some fancy AppleScript capabilities which allow for 
animating objects and moving them around the screen. He then showed 
us OmniOutliner which is the easiest and coolest software for making lists 
and outlines. He demonstrated lists containing media such as photos and 
even movies, and he showed how writers can use the software by opening 
a file containing a complete novel by Shakespeare organized as an outline.

He finished up the night by demoing OmniWeb which is a web browser 
with unique features like workspaces, graphical tabs, customizable search 
shortcuts, site-specific preferences, and save sessions. If you think that 
free web browsers like Safari and Firefox are the pinnacle of web browsing, 
think again. Brian also dropped a tip that OmniWeb is only $10 (normally 
$30) through the month of November, so get it while the getting’s good! 
As if all Brian’s demos and Q & A weren’t enough, Brian brought two 
copies of each of Omni’s shipping products with him for us to raffle off! 
Check the next issue of MacNews for more details. Thanks to Brian and The 
Omni Group for a great night!

Another MM review from Dick Harrell
dBug Main Meeting 11/8/06
OMNI Group 
Mike Grueter opened the meeting for Allan Swensson.  Brian Covey from 
Omni Group presented.

Brian is in charge of the QA department  and the support section at Omni 
Group. He demonstrated four Omni applications during the main meeting.  
Omni apps are designed for OSX.

OmniPlan is a project  planning app in progress. It is expected to be 
available by early 07, but you can download the Public Beta  now. For a 
first cut it has an impressive number of features. 

Project management is associated with big efforts like putting a man on 
the moon or building a floating bridge, but most of us have managed 
projects (or mismanaged them) without thinking of them in that way. 
Remodeling the bathroom or getting the family together for a reunion 
require the same kind of strategy and organization. 

OmniPlan has the tools for such jobs big and small. It lets you list tasks, 
order them in time, and assign resources and costs. It helps you find 
dependencies, bottlenecks, and overloaded resources. Its features include 
the basic set: Gantt Charts, critical path identification, resource leveling 
and more, all in a friendly interface that;s easy to use. You can export the 



results to MS project or other project managers, other Omni products like 
OmniGraffle and OmniOutliner, and in a variety of other formats, such as 
XML.  Exports to MS project

Omni expects OmniPlan to cost about $150 for a single license.

Omnigraffle Pro

Omnigraffle is a drawing application that is diagram-aware. Org charts, 
flow charts, diagrams, family trees, office layouts, and many more products 
are made easy to create and modify using this app. Sure, you can do this 
stuff with a generic drawing program, but OmniGraffle provides standard 
shapes and lets you create relationships between them that persist even 
as you rearrange the layout. That lets you toss your ideas on the page and 
let the application keep track of the relationships and clean up the layout. 
You can assign AppleScripts to objects. Version 4 improves many features, 
including exports to presentation apps like Keynote and Powerpoint and 
producing PDFs and PICT vector files. Brian demonstrated OmniGraffle Pro v. 
4. Standard OmniGraffle is also available.

OmniOutliner

All Mac products now ship with OmniOutliner pre-installed. Outlining is a 
way of organizing thought. The basic idea - make a list. Any list. Create 
hierarchies in the list. Sort the list in many ways. Create a pop-up list for 
standard choices for a line in the outline. Imbed movies, pictures, sound 
files. Create lists that don’t look like lists at all.  Drag and drop items to 
reorganize the list. Export the final product to Keynote or in a variety of 
other formats. AppleScript it, and interact with other AppleScript-able 
programs.



OmniWeb 5 30 /$10 this month

Omni’s powerful web browser has matured 
over the years. It has almost too many 
features to list. Yes - it supports XML and 
RSS. Yes - it blocks ads. Yes - it has tabbed 
browsing. Yes - it keeps your browsing 
history. But in most of those features and 
in many others it has unique features and 
capabilities. For instance, your tabs in tabbed 
browsing mode are in a tray to the right or 
left of the main window, maximizing vertical screen space. They include 
thumbnails of the sites that you can drag to reorder, or from one browser 
window to another. If you have a lot of tabs you can resize or eliminate 
the thumbnails.

Plus there are features you can’t find elsewhere, such as site-specific 
preferences. Most browsers let you set global preferences.

OmniWeb lets you do it differently for different sites. OmniWeb’s ad-
blocking features are powerful and customizable. With OmniWeb you 
can save workspaces - all the sites you go to for a given task, arranged 
the way you like them, opening with a single click. OmniWeb lets you 
bookmark a site’s search field, so that you can enter the short name you 
give it and the search term you want to find in OW’s search field and 
away it goes to that site to search for that term.  And you can easily tell 
OmniWeb to emulate another browser to access those sites that require 
some arcane browser to work or test a site in multiple browsers.

OmniWeb usually goes for $29.95 but is on sale in November for $9.95. 

Visit the Omni Group at <www.omnigroup.com> The Omni Group is located 
in beautiful Seattle, Washington. In 1989, the founders of The Omni Group 
began working with some of the technologies that form the basis of Mac 
OS X. The Omni Group was founded in 1993. 

Omni offered two copies each of the three shipping apps for our raffle. 
We also had a plastic shell for the MacBook Pro 15 inch model (in red) 
designed to protect and enhance the metal shell. The shell is from Speck 
Products. See dBug Benefits for a special code for a member discount.

dBug 2006 Board of Directors:
<http://www.dbug.org/about/bod.shtml>

Allan Swensson, President • Tom Auciello  
• Mike Grueter • Dona McAdam

dBug Resource Center directions:
<http://www.dbug.org/about/directions.
shtml>

Information on joining dBug:
<http://www.dbug.org/about/join.shtml>

While you are surfing, check 
out the current event calendar:              
<http://www.dbug.org/calendar/>

The dBug Brochure has been updated.

See it online at <http://www.dbug.org/
publications/brochure/>

November raffle winners


